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Technology Applications for the Exceptional Learner
Paper delivered at the National Catholic Educational Association
95th Annual Convention and Exposition
April 14-17 Los Angeles, CA
Dr. Janet Burke
Western Connecticut State University

This paper is a series of lesson plans designed to assist teachers with the
instruction of the exceptional learner. The focus is on identifying what the
exceptional learner needs, and provides specific lesson plans that meet those
needs. Exceptional learners experience difficulty with spelling, organization,
and metacognition. Detailed directions on how to use Microsoft Word are
provided. Microsoft Word can help solve everyday instructional obstacles.
This paper should be used as a detailed handbook for beginning and veteran
teachers.

3



Technology and Students with Special Learning Needs

HOW TO SET UP A MACRO ON MICROSOFT WORD 3

DIRECTIONS FOR USING AUTO TEXT ENTRY 4

HOW TO SET UP A TABLE OF CONTENTS 6

HOW TO UPDATE A TABLE OF CONTENTS 7

DIRECTIONS FOR USING WORD ART 8

DIRECTIONS FOR SORTING LISTS 9

DIRECTIONS FOR SETTING UP A FRAME 10

MAKING TEXT BOXES OVERLAP 11

INSTRUCTIONS FOR SETTING UP HYPERTEXT LINKS 14

DIRECTIONS FOR CUSTOMIZING THE TOOLBAR 16

DIRECTIONS FOR USING MAIL MERGE 17

4



Headings for the Students' Papers

Objective: Put a heading on a student's paper by striking only two keys.

A Macro is a series of operations, which are then assigned to keys that do all the work for you.

Example:

Janet Burke February 7, 1998

Mathematics Ms. Mary Smith (Teacher)

Too often, teachers end up with papers without student names. This can be frustrating for
teachers and students. It may help students, who are forgetful, to simply strike two keys to obtain
a professional heading on all assignments. Teachers can help their students to set up
headingsusing Macros. Macros help students to begin their papers with topics and names. This
will help the student's self esteem and reduce frustrations for the educator. The computer
directions throughout this paper were obtained from Seiter, C., Engst, E. & Sosinksy,B.(1995).
Microsoft Office. NY: Macmillan Computer Publishing.

How to Set Up a Macro on Microsoft Word

1. Select "Macro" from the Tools menu.

2. Click "Record New Macro."

3. Type the name of your Macro, (Janet). Give it any name you desire.

4. In the same dialog box, at the bottom, select "All Documents" so the Macro's heading
will be available for all class assignments.

5. Type a short description in the dialog box. (Optional)

6. Word places you in the Customize Keyboard dialog box. In the dialog box, "Assign" the
Macro to the "Keyboard".

7. At the bottom, of Customize Keyboard dialog box , "Press new shortcut key." To assign a
shortcut key, for example, press "Alt-0." To the right of the same Customize Keyboard
dialog box, click assign, then click close.

8. Type the heading for each student because Word is recording all the steps you execute.
Any command or typing you do is recorded. If you want the student to open a new file,
then record the heading, or you may decide this Macro will print a full page of directions
geared specifically for the needs of a student(s).

9. Click "Stop recording." Now type the shortcut key you assigned. In this case, "Alt-0,"
will type the student's heading and/or anything else you recorded.
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Directions for Using Auto Text Entty

Auto Text Entry will provide predictive spelling for students.

Example: A History or English Text with Constitution of the United States.

Constitution of the United States

The student types "Cons" then the computer will automatically print out "Constitution of the
United States."

Predictive Spelling with Auto Text Entry Why is this useful? Predictive spelling is useful for
students with learning disabilities because they often have difficulty with spelling. The teacher is
unable to assess the brilliance of the student because these rudimentary procedures of spelling
stand in the way.

Exceptional students have a difficult time spelling multi-syllabic words. With Auto Text Entry,
the teacher can anticipate the words in the lesson, which will give the student the most difficulty.
If the class is studying the Constitution of the United States and an assignment is given to write a
report about the Constitution, every time the student writes "Cons" the Auto Text Entry
automatically displays the "Constitution of the United States" for the student. The student then
presses "Return" to accept the suggestion.

DIRECTIONS FOR USING AUTO TEXT ENTRY

1. Type in whatever entry you want the Auto Text Entry to recall then highlight it.

2. From the toolbar, under "Insert," click "Auto Text." To the right of Auto Text, click "New."

3. You can accept the name generated by the computer or type at least four characters for the
particular entry. In this example, "Cons." was selected Use the beginning four letters of the entry
or word you want to see typed out for the student. This way your student will only have to type
those four letters to receive as big an entry as you deem necessary.

Another way to apply Auto Text Entry is:

1. From the toolbar, under "Insert," click "Auto Text." To the right, click "Auto Text" again.

6



2. When the Auto Text screen pops up, select "Normal.doc." In this way, the student will have
access to the Auto Text entry in all her assignments.

How Auto Text Entry Works.

In summary, instruct the students to type the report just as they normally would. This time when
the student types the first four letters of the Auto Text Entry the longer version of the word they
had difficulty with or the information you wanted inserted will automatically be typed.



How to Set up a Table of Contents

Exceptional students require a great deal of organizational skills. A table ofcontents can help
the educator and the student better organize their work.

Table of Contents

Introduction to story 5

Characters 7

Setting 8

Plot- 9

Ending 10

1. To begin this process, the educator should highlight information they would like to have
included in the table of contents. Next, select a "Style" from the style box below the toolbar.
The style box should say "Normal," change it to "Heading 1,2..." depending on the text's
importance.

2. Now position the cursor where you want the table of contents to appear.

3. Under "Insert", select index and tables. When the table of contents dialog box appears, click
on the "Table of Contents" tab. Do not use the Index tab window that automatically opens.

4. Click the "Show page numbers" so that a check mark appears in the box.

5. Select "Right align page numbers" so that a check mark appears in the box.

6. Select the "Tab leader" you desire.

7. On the right hand of the same dialog box, click "Options."

8. In the "Table of Contents Options" dialog box, make sure "Styles" is checked. If it does not
have a check in the box, put one in there.

9. Click "OK" twice.
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How to Update a Table of Contents

1. Highlight the Table of Contents

2. Press the key "F9."
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Word Art

Directions for Using Word Art

Too often the exceptional child suffers from a lack of self esteem. It is a small wonder when
everything they attempt academically ends in failure. Word Art can help.

Word Art allows them to see their name written with flair.

Or, use Word Art to help them remember vocabulary words.

ZEE
Word Art Directions

1. Under the "Insert" menu in the Toolbar, select "Object."

2. When the Drawing Toolbar Menu appears, select "Microsoft Word Picture" then click "OK.
The Word Art pop-up screen will appear.

3. Have the student type in her name. Try different styles to show the student how to display her
name.

4. Add this Word Art to the screen saver so the student is constantly reminded of their
importance, or use it to display the vocabulary word of the day.

8
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Sorting List

Exceptional students have difficulty with organization; therefore, "Sorting Lists" may be crucial
to keeping them organized. Students have different things to do during the day/week. "Sorting
Lists" may help them remember these assignments/tasks, if it is placed in alphabetical order.

Example:

Activities

Science Homework

History Homework

English Homework

Walk the dog

Shower

Art Homework

Call Mom or Dad

Pick up the mail

Send clothes to tailor

Cook dinner

Clean the dishes

Directions for Sorting Lists

1.

2.

3.

4.

5.

Activities to Do using Sorting List

Art Homework

Call Mom or Dad

Clean the dishes

Cook dinner

English Homework

History Homework

Pick up the mail

Send clothes to tailor

Science Homework

Shower

Walk the dog

Make a list of activities to do for each student or students.

Under Insert, select "Table," then select

The "$ore' pop-up screen appears.

Choose Sort by "Ascending Order."

Click "OK "

1 1



Focus on Homework

Directions for Setting up a Frame

Homework.

Math, page 78, problems,1-20.

History, page 32. Write an essay about World War H.

Science, page 45. Write the lab report on earthworms.

Drawing a
frame
around the
text may
help the
exceptional
learner focus
on the task
at hand like
the

homework assignment above. Please be careful and make sure their disability if any, is not
figure-ground discrimination.

1. From the toolbar, select "View." From View, select "Page Layout View."

2. Type and highlight what you want to frame.

3. Under "Insert," select "Text Box."

10
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Making Text Boxes Overlap

Meta Cognitive Skills

The exceptional learner does not have appropriate metacognitive skills. The educator must teach
the student how to learn by providing the exceptional student with cues to help focus on the
instructions. An assignment to read a passage from Mutiny on the Bounty may prove a difficult
one for the exceptional learner. The exceptional learner does not have the study skills to stop and
reflect on the meaning of the material. Instead, they hurriedly read, glossing over the material to
finish the assignment. Framing inserts may help them stop and take notice of some of the key
points the instructor wants them to learn or understand.

Example:

The exceptional learner does not have appropriate metacognitive skills. The teacher must teach
the student how to learn by providing the exceptional learner with cues to help her focus on the
instructions. For example, an assignment to read a pas from Mutiny on the Bounty may
prove a difficult one for the exceptional le e exceptional learner does not have the study
skills , they hurriedly read, glossing
over t Reflect on the word mutiny here. What does it mean? nserts may help them stop and
take n If you do not know the meaning, look it up in the to learn or understand.

dictionary.

Janet saw Fluffy in the tree.

She got a ladder from the tool shed.

Soon she took her little black kitten down.

Fluffy had a hurt pawl

Where did Janet find Fluffy?

Why did Janet take Fluffy inside?

Janet took Fluffy inside, and took care ot

Soon Fluffy was well, and Janet was happy again.

Making Text Boxes Overlap

1. In the toolbar, under "View," make sure you are in the "Page Layout View."

2. Under "View," choose "Toolbars," then select the 'Drawing Toolbar."

11
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3. In the drawing toolbar, select "Text Box."

4. Click and drag the text box on top of the selection the student is going to read.

5. The handles (square boxes on the lines of the box) around the text box allow you to shrink or
enlarge the box.

6. Type out your message to the student.

12
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Instructions for Setting up Hypertext Links

Objective: Giving exceptional students a great deal of work in small chunks.

Hypertext Links

Exceptional students are often overwhelmed when they see a great deal of print. The student(s)
know they are already experiencing trouble with reading. So that when they encounter a great
deal of reading, they often give up before really trying to read the work. A great deal of print to a
first grader can be defined as one page of print, to a twelfth grader it could be 100 pages.
Therefore, the teacher can give the lesson piecemeal. With hypertext links the educator can set
up an index, and the student can click on that index in order to get the information piecemeal
versus all at once. Please see the following sample lesson to understand how hypertext can Work
in your classroom.

Subject Instructions

Alexander the Great

Adolf Hitler

Aristotle

Fidel Castro

Cleopatra

Confucius

Martin Luther King

Pope Paul II

Double click here for information.

Double click here for information.

Double click here for information.

Double click here for information.

Double click here for information.

Double click here for information.

Double click here for infe ation

Double click here for information.

15

The student sees this portion of
the text.
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Alexander the Great

Adolf Hitler

Aristotle

Fidel Castro

Cleopatra

Confucius

Martin Luther King

Pope Paul II

United Greek city-states and conquered Persia.

Leader of Nazi party, led Germany in WWII.

Greek philosopher and logician

Cuban revolutionary leader.

Egyptian queen and ally ofJulius Caesar.

Philosopher on human relationships.

Civil rights leader.

The student is brought to
the single text that matches
her request only after
"double clicking the
individual names."

The current pope and spiritual leader of the Roman Catholic Church in
Rome.

Instructions for Setting up Hypertext Links

1.Highlight the information you want the student brought.

2.Under "Insert," drag the mouse to "Bookmark." In the bookmark dialog box, give the
information you highlighted a name. (The name must not have spaces. It must begin with a letter
and not be longer than 40 characters.)

3.Click the "Add" button in the left hand corner of the dialog box.

4.Put the cursor where you want your hypertext link("The Go To Button").

5.Go to the "Insert" menu and drag down to "Field."

6.In the "Field dialog box," under "Categories.," pick "Document Automation," then under "Field
Names " pick "Go To Button."

7.Click the "Options" button on the right of the dialog box.

8.The "Field Options" dialog box pops up.

9.Under the Bookmark Name list, select the name of the bookmark you formerly typed in step 2.

10.Click the "Add to Field" button on the right. The name of the bookmark will show in the text

14
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box at the bottom.

11.After the bookmark name you originally selected, type what you want the students to see
when they click on the "Go To Button".

12.The text that you write is referred to as the "Display Text," and it will be the information that
the student will see.

13.Click "OK," and this will return you tO the Field Dialog Box.

14.Click "0IC," and this will return you to the document.

15.Double click on the display text (Double click to learn about Alexander the Great), and the
student will be brought to that section.

15
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Customizing the ToOlbar for the Exceptional Student

Teachers may want to customize the toolbar for the exceptional students, for a variety of reasons.
Some students will require one icon at a time in order to master the entire toolbar. Other
students will depend extensively on one icon in order to get a project done. Whatever situation
you find yourself in, the following directions will help you customize a toolbar to meet the needs
of your students.

Directions for Customizing the Toolbar

1.Under "View" in the toolbar, select "Toolbars," then choose "Customize."

2.Under the toolbars tab, choose "Customize Dialog Box," click "New."

3.Give the Customize Toolbar a name for example, date. Now click "OK."

4.An icon for the toolbar will pop-up on the screen.

5.Click and drag that icon wherever you like it to appear on the toolbar menu.

6.Next click the "Commands" tab.

7.Click "Insert" for example, under categories, under the commands tab.

8.Under commands, select "Date " and then drag the icon from command to the newly created
icon.

9.Next select modify selection.

10. Change button image, select one. I chose the smiley face.

11. Hit the "Close key."

16
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Directions for Using Mail Merge

Starting the Main Document

1. Under "File " start a new document. You can open an old document if one exists.

2.Under "File " save the document. Name it "Main Document" so you can follow the directions
easier.

3.Under "Tools," choose "Mail Merge."

4.Under "#1 Main Document" the mail merge helper will appear. Click the "Create Button
Menu " and drag down to select "Form Letters." A dialog box appears, asking you which
document you want to use.

5.Click the "Active Window" button, and the type of merge appears. Form Letters and the name
of the main document appears beneath the create button.

Starting the Data Document

If the Data Document already exists,

1.Click the "Get Data" button and select "Open Data Source," an open dialog box appears, where
you can open the document.

2.Click the "Open button," if data document is ready, click the "Edit Main Document" button,
and continue with "Finalizing the Main Document."

If the Data Document does not exist.

1.Click "Get Data," and drag down to "Create Data Source." The create data source dialog box
appears.

2.Field Names indicate the categories of information.

3.You choose your field names by simply removing the fields you do not want, and the
remaining ones are the ones you maintain.

4.After selecting your field names, click "OK."

5.The "Save" dialog box pops up in order to save the data document. Type a name for the file
and click the "Save" button.

6.A dialog box appears, asking you whether you want to work in the data document or the main
document.

17
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7.Click the "Edit Data Source" button.

8.Enter the information in each field name. When you finish your first record, click "Add New"
to start a new record. Once you are finished entering all the information, "Click OK."

9.Finalizing the Main Document

10.Type your main document (letter). When you need to insert a field name in your main
document, make sure that the insertion point is located where you want the field to go. Click the
"Insert Merge Field" button, and choose the appropriate "Field Name."

Merging and Printing Form Letters

1.Make sure you are in the main document.

2.Click the "Mail Merge Helper" button and the mail helper dialog box appears.

3.If the Main Document's Name doesn't show under the Create button Menu, refer back to
starting the main document.

4.Click the "Merge" button, and the merge dialog box appears on the screen.

5.Go to "Merge To," and click on New Document and drag down to "Printer" (replace new
document with printer.

6.Click on "Print."

20
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